Handbook for Language Learning Resources at Winthrop University

David Kleinberg, Ph.D.
August 2008

Table of Contents

SECURITY IN THE LANGUAGE LAB ........................................................................................................................................................3
MAIN OFFICE: Copier / Scanner ..........................................................................................................................................................3

LAB EQUIPMENT

CONFERENCE ROOM – Room 307 Kinard Hall ........................................................................................................................................4
• Multi-Region DVD .................................................................................................................................................................................4
• Multi-Region VCR ....................................................................................................................................................................................4
• Dual-Head VCR ........................................................................................................................................................................................4
• Projector ......................................................................................................................................................................................................4
• Stereo System / Speakers ......................................................................................................................................................................5
• Instructor’s PC ......................................................................................................................................................................................5
• PC Workstations with Headphones x8 ...............................................................................................................................................5
• Satellite channels (FRENCH/SPANISH/GERMAN) ............................................................................................................................5
• VCR/TV Combo (x2) ...................................................................................................................................................................................6
• Slingbox tuner ........................................................................................................................................................................................6
• Digital Video Recorder (DVR) / Orb ......................................................................................................................................................6

LANGUAGE LAB – Room 307 Kinard Hall .............................................................................................................................................6
• Instructor’s PC ......................................................................................................................................................................................6
• PC Workstations with Headphones x24 ...............................................................................................................................................7
• VCR ........................................................................................................................................................................................................7
• DVD ......................................................................................................................................................................................................7
• LCD Projector ........................................................................................................................................................................................7
• Stereo System / Speakers ......................................................................................................................................................................7
• Satellite channels (FRENCH/SPANISH/GERMAN) ............................................................................................................................7

CLASSROOMS

Kinard Hall Rooms 319 / 219 / 119 .........................................................................................................................................................7
Kinard Hall SMART Classrooms ...........................................................................................................................................................8
Owens Hall SMART Classrooms ..........................................................................................................................................................8

EQUIPMENT TO CHECK OUT
• Mobile Carts ........................................................................................................................................................................................8
• Portable Stereo “Boom-boxes” ...............................................................................................................................................................9
• Digital Camcorder ..................................................................................................................................................................................9
• Digital Camera .....................................................................................................................................................................................9
• Laptop ....................................................................................................................................................................................................9
• Portable Multi-Region DVD ...............................................................................................................................................................9
• Video collection ................................................................................................................................................................................................9
SOFTWARE INSTALLED ON LAB PCs
- NetSupport................................................................................................................................. 9
- Audacity ...................................................................................................................................... 10
- Language Packs for Microsoft Office ......................................................................................... 10
- Google Earth ............................................................................................................................... 10
- Microsoft Photo Story 3 for Windows ........................................................................................ 10
- Foreign Language Textbook Supplements ............................................................................... 10
- Atajo ........................................................................................................................................... 10
- Switching language input settings ............................................................................................. 10
- JAWS and Screen Magnifier ....................................................................................................... 11

ONLINE TOOLS
- Online Dictionaries .................................................................................................................. 11
- Google Earth ............................................................................................................................. 12
- Google Image Search ................................................................................................................. 12
- Web radio ................................................................................................................................. 12
- Web TV ...................................................................................................................................... 13
- Orb.com ..................................................................................................................................... 13
- Wikis .......................................................................................................................................... 13
- WebCT ....................................................................................................................................... 13
- QUIA .......................................................................................................................................... 14
- MySpanishLab / MyFrenchLab .............................................................................................. 14
- Blaberize.com ............................................................................................................................ 14
- Voki.com .................................................................................................................................. 14
- YouTube ..................................................................................................................................... 14
- Sketchcast.com .......................................................................................................................... 15
- Comiqs.com ............................................................................................................................... 15
- Eyejot.com ................................................................................................................................. 15
- Chinswing.com ......................................................................................................................... 15
- Bubbleply.com ........................................................................................................................... 16
- Skype ......................................................................................................................................... 16

FOREIGN LANGUAGE PLACEMENT EXAM .................................................................................. 16

ADDITIONAL RESOURCES ......................................................................................................... 17

APPENDIX A: NetSupport School / Tutor 8.0.............................................................................. 18
APPENDIX B: Audacity .................................................................................................................. 19
APPENDIX C: United States – International Keyboard Layout .................................................. 20
APPENDIX D: Smart Podium Instructions .................................................................................. 21
APPENDIX E: Instructions for Foreign Language Placement Exam (FLPE)............................... 24

Acknowledgments:
Thanks to Felix Kronenberg (Pomona College) for making his Pomona Language Technology Boot Camp Manual available to the public, which served as inspiration for much of the content here. Thank you to Suzanne Sprouse (e-Learning Coordinator at Winthrop University) for providing the handouts for the Symposium SMART Classroom Podium. Thanks to Marshall Jones (College of Education at Winthrop University) for providing in-depth instructions for Audacity and many other tutorials. Thanks to Trip Kirkpatrick (Center for Language Study at Yale University) for taking copious notes from the CALICO/IALLT conference and posting them.
SECURITY IN THE LANGUAGE LAB: Please note that the Language Lab is equipped with keypad lock on the door, an alarm system and security cameras in both rooms. If you will use the lab after normal working hours or on the weekend, you will need to know both the door code and the alarm code. If you are using the lab in the evening, you will be expected to set the alarm before you leave. For the codes and instructions on how to arm and disarm the security system, please see the lab director or department chair. If the lab is locked and alarm is set, and no one else is around who can help you, contact campus police at x3333 and they can unlock the room or lock it after you leave. The mobile carts is also locked by a security cart, and much of the loanable equipment is locked up in the cabinets. Please help us to prevent theft by locking up and promptly returning any borrowed equipment so we can secure it.

MAIN OFFICE: Copier / Scanner: The photocopier in the main departmental office can not only make copies in black and white, it can be used as a high speed scanner. It can quickly scan your documents and create a PDF file (Adobe Acrobat format), which it then send to you via email. There is no charge to scan documents. The automatic document feeder allows you to place a stack of pages to be scanned all at one time into the scanner. This is a very easy way to create handouts for your students, and if you distribute the PDF file to your students, instead of photocopies, you can save the department significant copying cost. You will need to have your email address added to the scanner/copier’s address book, so that it can email you your documents without having to type your address every time. Ask the department chair, secretary, or lab director to do this for you.

- To scan documents:
  1. Log in with your copying code.
  2. Push the “SCAN” button.
  3. Select the destination: choose your email address from the address book.
  4. Select SCAN SETTINGS: you can indicate whether the original document is one-sided or two-sided, and change the resolution of the scan for better detail. 300 dots per inch (dpi) is recommended. Higher dpi means the scan will be clearer, but the file sizes will be much larger.
  5. Press the copy button.
  6. Your scanned PDF file will be in your email box a few seconds later.
LAB EQUIPMENT

CONFERENCE ROOM – Room 307 Kinard Hall (Right side)

This room is set up as a conference room with a large central table and comfortable chairs, ideal for smaller classes to hold discussions or to screen films. It does not work well for classes with more than about 12 students. There should be a graduate assistant or a work-study student lab assistant to help you with any of the equipment during regular class hours. You may request this room for your classes or special meetings. This room can also serve as a tutoring center when it is not in use by other classes.

- **Multi-Region DVD:** The DVD player in this room can play DVDs from all regions (1: USA and Canada, 2: Europe and Japan, etc.) Some DVDs that are produced for foreign markets will not play in regular DVD players, but this player can handle just about everything. The remote control for this DVD player is in the desk drawer at the teacher’s station (look for the one labeled APEX).

- **Multi-Region VCR:** The VCR in this room can play videocassettes from NTSC, PAL, or SECAM formats. The remote control for this VCR is in the desk drawer at the teacher’s station. To display the video from the multi-region VCR, you need to press the “TV View” button on the remote for the DUAL-HEAD VCR until it says “LINE 1” on the screen.

- **Dual-Head VCR:** This VCR is the easiest VCR to use, and also controls the satellite channels (see below). It can play from two different videocassettes, record from the satellite channels onto videocassette, or record from on videocassette to another. It will only work with videocassettes produced for the North American market. It will not play videos purchased outside of the United States or Canada. The remote control for this VCR is in the desk drawer at the teacher’s station (look for the one labeled “Satellite TV & VCR”).

- **Projector:** The LCD projector mounted to the ceiling can display video from the instructor’s PC, the dual-head VCR, the Multi-region DVD player, and the multi-region VCR (playing through the dual-head VCR). Directions for selecting the appropriate input for the projector are on top of the teacher’s station. To turn on the projector, make sure that the remote’s power switch is switched to “ON” and hit the power button ONCE. To turn off the projector, hit the power button TWICE.
• **Stereo System / Speakers**: the room is equipped with an amplifier and speakers to play audio from the instructor’s PC, the DVD player or VCRs. There is a power switch on the cabinet that needs to be switched ON for the speakers to work. If the power is on, the green light will be lit on both the cabinet and the volume control on top of the desk. There are separate volume controls for the different devices. The volume can be extremely loud, so be sure to turn the volume down before starting, then gradually turn up the volume knobs.

• **Instructor’s PC**: the instructor’s workstation has software identical the students’ workstations, but you can display your screen to the class using the LCD projector. This is the computer to use if you are giving PowerPoint or any other multimedia presentations. You can also use this computer to play DVD movies. To play a DVD film, use the PowerDVD software. The NetSupport Tutor software is also installed on this workstation, which can be used to control students’ workstations (see “Software installed on PCs”). If you need a set of headphones or microphone for this workstation, you can borrow one from the lab assistant’s desk or the lab director.

• **PC Workstations with Headphones x8**: These computers are the standard Dell desktops used in all of the ACC computing labs across campus. They are installed with all of the same software as the other labs, including specialized software for foreign languages and handicapped students. (See “Software installed on PCs” below.) These computers have headsets and microphones installed, which allows students and instructors to record their voice, to communicate online via voice, and to listen to audio online. Many of the headsets have volume controls on the cable, so if they do not seem to be working, try turning up the volume or turning off the mute function.

• **Satellite channels (FRENCH/SPANISH/GERMAN)**: Winthrop subscribes to several foreign-language television broadcasts through DishNetwork. These channels are available on the campus academic television network. Any classroom with a cable TV feed (such as the SMART classrooms and the language lab have three channels of foreign language programming. Currently these packages include TV5 Monde (French) on channel 34, ProSiebenSat.1 Welt (German) on channel 33, and LatinoDish on channel 35 (over 40 different Spanish-language channels, but only one can be viewed at any given time).

You can check the broadcast schedules of TV5 Monde (French) at [http://www.tv5.org/](http://www.tv5.org/), and ProSiebenSat.1 Welt (German) at [http://www.prosiebensat1welt.com/incl/media/Wochenvorschau.pdf](http://www.prosiebensat1welt.com/incl/media/Wochenvorschau.pdf). In the LatinoDish package, there are over forty channels of Spanish-language programming. You can check the broadcast line-up here: [http://www.dishnetwork.com/content/dishlatino/](http://www.dishnetwork.com/content/dishlatino/). We will need notice one day ahead of time of you wish to watch or record a specific program from one of the Spanish-language channels, as we have to change the channel over in Tillman Hall where the satellite receivers are located.
• **VCR/TV Combo (x2):** These units allow students to watch VHS cassettes with headphones so that they do not disturb anyone else in the lab. These are ideal for students who missed a screening in class or are watching additional films as extra credit.

• **Slingbox Tuner:** this device transmits the television feed (including the foreign language channels) over the internet to computers running the SlingPlayer client software. In this way, the foreign language channels can be viewed in classrooms or offices that do not have a cable-TV connection. Only one client can connect to the Slingbox at any time, and does not work from off-campus.

• **Digital Video Recorder (DVR) / Orb:** the PC on top of the instructor’s desk is connected to the television feeds, including the foreign language channels via satellite. This computer can record television broadcasts to the hard drive (like a Tivo), which can then be burned onto DVDs that can be played in any classroom with a PC or a DVD Player. If you would like to have a television program recorded, please let the lab director know ahead of time so that the recording can be scheduled. The Orb software (see [http://www.orb.com](http://www.orb.com)) allows the video to be streamed to computers across campus using standard media software such as Windows Media Player.

**LANGUAGE LAB – Room 307 Kinard Hall (Left side)**

This room is configured much like the other computer labs on campus, with rows of computers and a teacher’s workstation. This classroom is well equipped for multimedia and computer-based presentations.

The lab is regularly scheduled for language classes, which meet once every two weeks in the lab. At times when no class is scheduled in the lab, it can be used by students as an open lab. Language courses always have highest priority. To reserve the lab for additional class meetings in addition to the regularly scheduled classes, please contact the Lab Director.

• **Instructor’s PC** (same as in the conference room): the instructor’s workstation has software identical the students’ workstations, but you can display your screen to the class using the LCD projector. This is the computer to use if you are giving PowerPoint or any other multimedia presentations. You can also use this computer to play DVD movies. The NetSupport Tutor software is also installed on this workstation, which can be used to control students’ workstations (see “Software installed on PCs”). If you need a set of headphones or microphone for this workstation, you can borrow one from the lab assistant’s desk or the lab director.
• **PC Workstations with Headphones x24** (Same as in the conference room): These computers are the standard Dell desktops used in all of the ACC computing labs across campus. They are installed with all of the same software as the other labs, including specialized software for foreign languages and handicapped students. (See “Software installed on PCs” below.) These computers have headsets and microphones installed, which allows students and instructors to record their voice, to communicate online via voice, and to listen to audio online.

• **VCR**: The VCR in the language lab is a standard VCR and cannot play videos produced in foreign countries (PAL or SECAM formats). This VCR is also used to change the channels of the foreign-language television programs.

• **DVD**: The DVD player plays only Region 1 DVDs. It is not Region-Free. If you want to show a film in the language lab that is not from the U.S. or Canada, you will need to borrow a region-free player from the Lab Director.

• **LCD Projector**: The LCD projector mounted to the ceiling can display video from the instructor’s PC, the VCR, and the DVD player. Directions for selecting the appropriate input for the projector are on top of the teacher’s station. To turn on the projector, make sure that the remote’s power switch is switched to “ON” and hit the power button ONCE. To turn off the projector, hit the power button TWICE.

• **Stereo System / Speakers**: the room is equipped with an amplifier and speakers to play audio from the instructor’s PC, the DVD player or VCR. There is a power switch on the cabinet that needs to be switched ON for the speakers to work. If the power is on, the green light will be lit on both the cabinet and the volume control on top of the desk. There are separate volume controls for the different devices. The volume can be extremely loud, so be sure to turn the volume down before starting, and then gradually turn up the volume knobs.

• **Satellite channels (FRENCH/SPANISH/GERMAN)**: the foreign-language television programs can be played through the VCR to the large projector screen. See the entry under “Conference Room” for more information.

**CLASSROOMS**
Many of the classrooms on campus have been equipped with SMART technology, including a Windows PC, DVD player and VCR, LCD Projector, and in some case a document reader (similar to an overhead projector.) Before you use any of the equipment during class-time, it is suggested that you try it out beforehand to familiarize yourself with the equipment.

**Kinard Hall Rooms 319 / 219 / 119**: These classrooms are equipped with large projection televisions, VCR and DVD players, and have cable television feeds of the foreign-language programming (French, Spanish and German). If you need help using any of this equipment, please contact the Lab Director. The DVD players in these rooms will only play Region 1 DVDs.
**Kinard Hall SMART Classrooms:** These classrooms have LCD projectors, Windows PCs, VHS and DVD players, and a document camera. It is easy to show films or make multimedia presentations in these classrooms. You will need a special key to unlock the consoles and gain access to the equipment. The DVD players will only play Region 1 DVDs. A remote control for the projector should be in the console with the computer and DVD/VCR.

**Owens Hall SMART Classrooms:** These are the newest classrooms on campus, and are all equipped with a Windows PC, VCR and DVD player, an LCD projector, and a document camera, which works like an overhead projector and can display any type of document on the projector screen. It is also possible to use your own laptop with the classroom projector. Each device is selected by pressing one of the white buttons on the top of the instructor’s console station. The monitor on the console also serves a whiteboard and can be marked on using the provided stylus (like the telestrator used in televised sporting events.) For more information on using the Symposium screen and the document camera, see Appendix D.

**EQUIPMENT TO CHECK OUT**

The Department owns some equipment that can be checked out and used in classrooms that are not already equipped with computers, projectors, DVD players or VCRs. There are calendars outside the storage closet on the second floor and in the conference room (307 Kinard) where you can reserve the equipment. The equipment is available on a first-come, first-served basis.

- **Mobile Carts:** These carts contain all the multimedia equipment you might need in a classroom that is not equipped as a SMART classroom: LCD Projector with speakers, laptop, DVD Player and VCR.

  If you are unable to log in to the computer with your own account and password or the “visitor” account, make sure to plug the Ethernet network cable into one of the jacks in the wall of the classroom you are in.

  If you are unable to get the laptop to send its video signal to the projector, hold the blue “**Fn**” key and the “**F8**” key. The laptop will cycle its display between the laptop screen, the projector, or both.

  To display the DVD or VCR video on the projector instead of the laptop, press the “**Video**” button on the top of the projector. To switch back to the laptop’s video, press the button labeled “**Computer/YPbPr**.”

  There are two carts, one in the conference room on the third floor, and one in the storage closet behind the main office on the second floor. You should check either one out depending on which floor you are teaching on, as this will save you time hauling it up or down in the elevator. These carts are not to be used in other buildings. The cart in the conference room is locked with a cable, and you will need the lab director or one of the lab assistants to unlock it for you.
• **Portable Stereo “Boom-boxes”:** the department has several portable stereos that can play cassettes or compact discs (CDs). They do not work well to record students’ voices. Classrooms that already have a PC in them can also play CDs, thus you would not need to borrow one of these stereos.

• **Digital Camcorder:** this Sony Handycam video camera records onto digital tape, which can be easily transferred to computer and burned onto a DVD. This is useful for class projects that require video, or to record oral presentations or exams. Each tape can record 60-90 minutes of video. The HandyCam can also be used to take still pictures which are saved to a Memory Stick and be copied to a computer or printed out. There is also a tripod to allow for steady recording. Check this camcorder out from the lab director.

• **Digital Camera:** this digital camera can be used to take pictures that are easy to upload to web pages, or printed out at any store that photo developing (Target, Wal-Mart, Walgreens, etc.) The pictures are stored on a small card in the camera which can be removed and copied using a card reader on a PC. Check this camera out from the lab director.

• **Laptop:** the department has a Dell Latitude D600 laptop available to loan to instructors for use at conferences or in the new SMART classrooms. This laptop is identical to the two laptops on the multimedia carts. It can play DVDs and is good for basic web surfing and presentations. It has wireless and wired Ethernet connections. There is a sign-up sheet in the language lab, and you can get the laptop from the lab assistants or lab director.

• **Portable Multi-Region DVD:** the lab director has a portable DVD player that is region-free, and can be used in any classroom where you need to play a DVD which is not from region 1 (U.S.A. and Canada). It also has a remote control.

• **Video collection:** the department owns approximately 600 VHS videos and DVDs. Most of them are on the shelves in the storage closet behind the main department office. Newer acquisitions have been catalogued by the Dacus Library staff and can be found in the online card catalog. Go to [http://library.winthrop.edu/screens/othcoll.html](http://library.winthrop.edu/screens/othcoll.html) and click on “Modern Languages Department Videos.” Movies that have been catalogued are sorted on the shelf by their Library of Congress (LOC) call number. Older films that have not been catalogued are sorted on the stacks by their acquisition dates (older films first).

**SOFTWARE INSTALLED ON LAB PCs**

• **NetSupport:** this software gives the instructor the ability to control what the entire class is doing on the computers in the lab. You can lock students’ workstations, monitor what they are doing, display your screen or a single student’s screen to all other students, and communicate via headset with individual students. For in-depth instructions on NetSupport, see Appendix A. To start the NetSupport Tutor software, click on “Start” ➔ “NetSupport School” ➔ “NetSupport School Tutor”
• **Audacity**: this is a simple program to record and edit MP3 files. Using the headsets installed in the language lab, one can easily record their own voice. This is useful for practicing pronunciation, for assessment purposes at the beginning and end of a semester, or as an oral exam. It is free, and can also be downloaded to your personal computer from [http://audacity.sourceforge.net](http://audacity.sourceforge.net). For brief instructions, see Appendix B. For an in-depth tutorial, see: [http://coe.winthrop.edu/jonesmg/lti/podcasting/podcast_audacity.pdf](http://coe.winthrop.edu/jonesmg/lti/podcasting/podcast_audacity.pdf).

• **Language Packs for Microsoft Office**: Microsoft Office (Word, Excel, etc.) has spelling and grammar proofing tools for English as well as many other languages. The computers in the lab have proofing tools for many national and regional standard varieties of English, Spanish, French, German, Arabic, Chinese and Japanese. You can also have the proofing tools installed on your office computer by the Information Technology department (call 323-2400). To check the grammar or spelling of your document, in Office 2003, highlight the text you want to proof, and select “Tools” → “Language” → “Set Language,” and choose the desired language from the list. In Office 2007 (installed in the computer labs), Click on "Review" → “Proofing” → “Set Language.”

• **Google Earth**: similar to Google Maps, but much faster and more fun to use. Quickly navigate the globe using satellite imagery. You can zoom in and out using the scroll wheel, and you can navigate through 3D representations of many cities.

• **Microsoft Photo Story 3 for Windows**: this software allows you to set up a slideshow of photographs with narration. It is very easy to use, and you can produce short projects in a matter of minutes. Select photographs, and then record your own voice to narrate the pictures. You can also add music, captions, and special effects to your presentation. For example, have students use a foreign language to talk about their own family and illustrate the narrative with family photos. Or tell a funny story and use photographs to accompany the story. For more information, or to download a (free!) copy of Photo Story 3 for your own computer, go to: [http://www.microsoft.com/windowsxp/using/digitalphotography/photostory/default.mspx](http://www.microsoft.com/windowsxp/using/digitalphotography/photostory/default.mspx)

• **Foreign Language Textbook Supplements**: The CD-ROM supplement for *Paralleles* (French textbook), *Plazas* (Spanish), and *Punto y aparte* (Spanish) are all available on the lab computers. Click on “START” → “Programs” → “Language Lab” to find these programs.

• **Atajo**: This is a grammar and spellchecker for the Spanish language. Click on “START” → “Programs” → “Language Lab” → “Launch Atajo”.

10
• **Switching language input settings:** The keyboard can be configured to easily input all of the **special characters** necessary for foreign languages, such as ñ, á, à, ä, ß, etc. For directions on configuring the keyboards for an international layout, see Appendix C. These instructions are also available in the language lab or from the lab director.

  o To install the US-International keyboard layout on your own computer in Windows XP: 1.) Got to “Start” → “Control Panel.” 2.) Click on the icon labeled “Regional and Language Options.” 3.) Click on the “Languages” Tab. 4.) Click on the button labeled “Details.” 5.) Under “Installed Services,” click the “Add…” button. 6.) Check the box labeled “Keyboard Layout/IME” and choose “United States – International” 7.) Click the OK button on all open boxes.

• **JAWS and Screen Magnifier:** All major Winthrop University computer labs and Dacus Library are equipped with large screen monitors and accessible software for students with low vision. Visually impaired students can use JAWS software, which reads the text of anything on the computer screen. The voice can be altered to read foreign languages with an approximately correct pronunciation. The screen magnifier software allows the screen to be zoomed in, so that everything appears much larger. If you have a student with special needs, you will be contacted by the Office of Services for Students with Disabilities, and they will train the students to use the appropriate software.

**ONLINE TOOLS**

These tools are all available online at no cost. Some websites may require you to register in order to receive their full benefit, but many can be used right away without registering. Many of these tools can be used in the language lab for your entire class as activities that will be both educational and entertaining, without wasting too much time having to explain the tools or set them up. There are always new tools being introduced, so this list is just a snapshot of some of the tools available right now. Because many these free services are in still in a developmental stage, they could disappear or start charging money at any time.

• **Online Dictionaries:** These services can translate words and phrases quickly between languages. This can save time with homework, writing lesson plans, and the students do not have to carry a heavy dictionary with them if they are using the lab or have Internet access.

  o [http://dict.leo.org](http://dict.leo.org): (Link Everything Online) Excellent **German/English** and **English/German** dictionary. This website also has links to conjugations of verbs and declinations of nouns (Click on the blue i icon next to an entry for definitions, declinations and conjugations, and pronunciations). There are also Spanish/German, French/German, Italian/German, and Chinese/German dictionaries available.

  o [http://www.yourdictionary.com/languages.html](http://www.yourdictionary.com/languages.html): a comprehensive list of online foreign-language dictionaries. Find a few that you could recommend to your students.

  o [http://babelfish.yahoo.com](http://babelfish.yahoo.com) or [http://translate.google.com](http://translate.google.com): translation services that can translate paragraphs or whole web pages between many different languages. Sometimes useful for quick translations, however the grammar is often atrocious (try translating an English text into a foreign language and then back again.) Students may try to use this for their homework and the results are usually catastrophic, so you should be familiar with it.
• **Google Maps**: [http://maps.google.com](http://maps.google.com): In addition to being fantastic for getting driving directions, if you click on the “Satellite” button, there is satellite imagery of the entire world. You can use this to get an overhead view of domestic and foreign countries. Find famous landmarks or practice giving directions in foreign languages. You can use the scroll-wheel on the mouse to zoom in and out quickly. You can also get to Google Maps by starting at [www.google.com](http://www.google.com) and clicking on the link to “Maps.” Remember, “Google is your friend.”

• **Google Image Search**: [http://images.google.com](http://images.google.com): You can easily find pictures and graphics to illustrate your PowerPoint presentations, web pages, flyers, and for any other purpose. Just click in a few key words and Google will quickly give you many useful images, such as famous personalities, landmarks, traffic signs, and anything else you can think of. You can also get to Google Image Search by starting at [www.google.com](http://www.google.com) and clicking on the link to “Images.” Never forget, “Google is your friend.”

• **Web radio**: many radio stations also simultaneously broadcast (“simulcast”) their programming over the internet. Internet radio in foreign languages is ideal as background music while working on homework or planning lessons, and there are typically news updates, local weather, and traffic reports on the hour and half-hour. You could listen to the latest news at the beginning of a class period and then lead a discussion with your students to check how much they understood. This is a fantastic way to stay abreast of current events and culture in foreign countries as well. You may need RealPlayer, iTunes or Windows Media Player to play the streaming audio. Check the websites of broadcasters in the target country to see if they have an Internet stream.


  o **Shoutcast** [http://www.shoutcast.com](http://www.shoutcast.com): This is a congregator for thousands of Internet radio stations. You can use free software, such as WinAmp ([www.winamp.com](http://www.winamp.com)) [Recommended] or Itunes ([www.apple.com/itunes](http://www.apple.com/itunes)) [Already installed on campus PCs] to play the radio feeds. There are many hundreds of feeds that originate in other countries and other languages. There is also a similar “Shoutcast TV” service that streams video form around the world. Some video is very mundane, some are familiar American television shows and movies dubbed into foreign languages. WARNING: many channels have extremely adult content, but you can filter it out from your searches, so that you do not see links to the adult content.

  o **AOL Radio** [http://radio.aol.com](http://radio.aol.com): Over 350 internet radio stations in one place. There are several channels with foreign/international music at [http://music.aol.com/radioguide/world-radio](http://music.aol.com/radioguide/world-radio).

  o **Satellite radio** services, XM and Sirius, also broadcast many of their channels over the Internet, although you may need to be a paying subscriber. Sirius carries several Spanish and French-language channels, for example. XM makes many of its radio channels available for free over the Internet, for example if you are using WinAmp software.
• **Web TV:** Many broadcasters make excerpts of their television programming available over the Internet, or even broadcast their regular programming live over the Internet. You should screen the content before using it in the classroom, as some may be of an adult nature.
  
  - [http://beeline.tv](http://beeline.tv) or [http://beelinetv.com](http://beelinetv.com): A Dutch Website which lists hundreds of live Internet TV stations from many different countries.
  
  - [http://wwitv.com/portal.htm](http://wwitv.com/portal.htm): World Wide Internet TV, a website with links to thousands of international Internet television stations.

• **Orb.com:** The Orb software allows you to share media from your own computer to other computers over the Internet. You can share videos, music, and other files. The DVR computer in the conference room has Orb installed and can stream the satellite video feeds to other computers on campus or off. This is one way to use the foreign-language satellite feeds in classrooms that do not have a cable television connection.

• **Wikis:** A wiki is a collection of web pages designed to enable anyone who accesses it to contribute or modify content. Wikis are often used to create collaborative websites and to power community websites.
  
  - The collaborative encyclopedia, [Wikipedia](https://en.wikipedia.org), is one of the best-known wikis. Wikipedia is available in many different languages and can be a valuable research source for foreign-language projects, although some of the information can often be inaccurate, as anyone can edit the text. It is recommended to only use it as a starting point, not a single source.
  
  - You can create your own Wiki to use with your students. Everyone can contribute to an online discussion, comment on each other’s submissions, etc. You do not need how to program a computer or write a web page yourself. Some free Wiki services include [http://www.wetpaint.com](http://www.wetpaint.com) and [http://www.ourproject.org](http://www.ourproject.org) [largely in Spanish]. You will need to create an account on these websites, and your students may also need their own accounts in order to contribute.

• **WebCT:** [http://online.winthrop.edu](http://online.winthrop.edu): This is course management software. You may already be familiar with BlackBoard, Moodle, or Sakai, which all perform a similar function. This is essentially an online service to distribute content to your classes, such as syllabi, handouts, homework assignments, links to other online sites, or multimedia such as MP3 music files or video clips. Only students who are enrolled in your classes can access the materials you post, which allows you to post material without breaking copyright laws (“fair use” for a classroom). WebCT provides a template for you to post your material, and you don’t need to know how to create your own webpages. Additionally, WebCT gives you the ability to host chat-rooms and discussion boards for your courses, give quizzes online (which can be graded automatically), a homework dropbox, post announcements, email the entire course at once, and post grades. Students will become familiar with the format quickly, as it will be similar for all courses across Winthrop, and they can access all courses in which they are enrolled from one web page. WebCT can also significantly reduce the cost of copying and printing materials for your students, because all materials can be posted online at no cost. It is strongly recommended that you take the Teaching and Learning Center’s workshop to become familiar with WebCT.
• **QUIA** [http://www.quia.com](http://www.quia.com): Quia is a commercial service that hosts the workbooks for many of the textbooks that we use. Students purchase a license to access their textbook or workbook when they purchase their textbooks. If a student purchases a used textbook, they will have to purchase an extra license directly from the Quia website. Instructors set up a class section on Quia, and the students enroll in that section online. Their homework assignments are then automatically graded and submitted to the instructor.

• **MySpanishLab.com / MyFrenchLab.com**: these websites are similar to Quia, in that they contain the workbook exercises and other supplementary materials for Spanish and French textbooks from Pearson – Prentice Hall. Students gain access to these websites when they purchase their textbooks.

• **Blabberize.com**: a Blabber is a talking picture. Upload a favorite picture, record your voice, then mark the outline of a mouth on the picture, and this website creates an animation of the picture talking. It looks a lot like the crude animations from Monty Python’s Flying Circus, but it is a lot of fun and very amusing. Have your students create their own Blabbers. They can write a script and then record it on the computer, or just ad-lib. You can create web-links to share your Blabbers amongst students or with friends. You do not need to create an account on this website in order to use it, but if you want to save your work you should create an account, which is free and fast.

• **Voki.com**: create a talking avatar. Create a cartoon character that resembles you (or anyone at all), record your voice and have the avatar speak for you. There are also pre-created avatars that you can choose from. You can create web-links to share your speaking avatar amongst students or with friends, or link to it from your own web-page, blog or wiki. You can record your voice, upload an audio file, type a short text for the avatar to read, or even phone in your message if you don’t have a microphone! You do not need to create an account on this website in order to use it, but if you want to save your work you should create an account, which is free and fast.

  Another neat feature is the dice button that randomly displays a new avatar. Put up random avatars on the projector screen, and have your students describe what they see using the foreign language: “That is the man with the long hair and blue eyes… That is the alien with the six eyes and purple skin… that is the woman with green hair, green lips, and pink sunglasses…”

• **YouTube**: find videos of just about anything by searching on YouTube. Show your students excerpts from foreign TV shows, or use the video from a song that you use in class. Have the students create their own videos with a camcorder and post them to the web. You can now annotate videos on YouTube, so you can add subtitles or explanations.
  – [http://ares-tube.en.softonic.com](http://ares-tube.en.softonic.com): save YouTube videos to your local computer. If you want to use YouTube videos in class, you won’t need to worry that they might be removed or that the Internet is
not working when you want to show them. Take them to class on a memory stick or burned on a CD/DVD. This software is free to download and use.

- **Sketchcast.com**: Create sketches (Pictionary-like) with voice recording. Have your students create drawings and record their voices to explain the drawings. Have them describe their home, or the route they take to school/work, or just draw stick figures of their family or friends. You need to register to use this website. You can create web-links to share your Sketchcast amongst students or with friends, or link to it from your own web-page, blog or wiki.

- **Comiqs.com**: create comic strips with pictures and text, and tell a story. This is a very easy exercise for students using their own pictures, stock photos from the website, or graphics from other sources such as Google Image Search. They can create short dialogs or longer stories, and illustrate them. You do not need to create an account on this website in order to use it, but if you want to save your work you should create an account, which is free and fast.

- **Eyejot.com**: record video messages using a webcam or the built-in camera on your laptop, then email them to a friend, students, teachers, etc. Your students could use this service to record oral presentations, to practice pronunciation, or just to practice oral proficiency. This could be used as a homework assignment when it is not possible to have live interaction. This offers some advantages over voice-only recording, as it is easier to understand the speaker when you have visual clues such as their expressions or hand gestures. Very easy to use. You will need to create an account to use this, but it is free and easy to do.

- **Chinswing.com**: this is a discussion forum where you can leave recorded audio messages instead of typed text. Set up a page for your class where everyone can leave messages. This allows them to practice speaking and can be quicker than a writing assignment. Because it is an open service, you may find that some native speakers will drop in and leave some input also.
- **Bubbleply.com**: Add pop up bubbles to any video, like the old Pop-Up Videos on VH1. Use your own video or take a video from YouTube, for example. This is fast and easy to use. There is an excellent demo here: [http://www.bubbleply.com/demo.aspx](http://www.bubbleply.com/demo.aspx). You can save your work and share with others. You will need to create an account, which is free and fast.

- **Skype**: Internet telephone and videoconferencing. If you have a microphone and headphones (as in the language lab) you can make free telephone calls to other Skype users anywhere in the world. If you have a video camera, such as a webcam or a built-in camera in your laptop, you can also videoconference for free. The quality is very high, even on international calls/videoconferences. You can also use Skype to call to regular telephones at very low rates. You need to create an account and install the software on your computer, but there is no cost for computer-to-computer calls. Use this service to talk to native speakers in other countries, or link your class to another class somewhere else in the world. Have two students call each other to practice speaking the foreign language with each other. **Please note**: this software is not currently installed on the lab computers.
  - **Callgraph** [http://www.callgraph.in](http://www.callgraph.in): this is free software to record a Skype call. Now you can have two students record a dialog with each other which includes both the audio and the video of both partners.

**FOREIGN LANGUAGE PLACEMENT EXAM**

The Modern Languages Placement Exam is used to determine what course level students should take for their foreign language course. The test is designed to determine the appropriate course level for students continuing their previous study of **French**, **German** or **Spanish**.

All students majoring in programs in the College of Arts and Sciences (except the BSW - Social Work) are required to have competency in a language at the 102 level. In the College of Visual and Performing Arts only the BA in Art and Art History are required to have competency in a language at the 102 level. Some programs, e.g. English, also require students to complete a 201-level course in a foreign language. Pre-Majors (undeclared majors) should also take the Language Placement Exam.

The placement exam is normally given to incoming freshmen and transfer students during their orientation sessions in the language lab, Kinard Hall, room 307. Any individual wishing to take the placement exam at any other time during the school year should contact Dr. David Kleinberg at (803) 323-4660. The test typically takes 20-30 minutes, but you should plan for up to 60 minutes.

Winthrop University uses [WebCAPE](http://www.winf.ac/cape) (Computer Adaptive Placement Exam). The test is multiple-choice, and typically takes 20-30 minutes, but you should plan for up to 60 minutes. Placement exam results are available to students immediately after finishing the exam, and student's advisors will have access to their placement scores as well, prior to registration during orientation. The possible placements in German, Spanish, and French are 101, 102, 201, or 202. Some students may be at a very advanced level already, but the test can only determine the precise level for the first three semesters. Therefore, students placing into the 201 or 202 levels for French, Spanish or German will be told to meet with Prof. Ken Gordon, the department chair of Modern Languages, to...
discuss what course would be most appropriate beyond the elementary level. They can contact Prof. Gordon at his office, Kinard 225, or at 803-323-2534.

For the instructions used during the placement exam, see Appendix E. Refer to the departmental webpage for any additional details and any changes in procedure.

ADDITIONAL RESOURCES

Instructional Technology Center at Winthrop University: http://coe.winthrop.edu/itc/: The mission of the College of Education's Instructional Technology Center is to provide an instructional laboratory environment with computers and other technologies for use by pre-service and in-service teachers, college faculty, and staff. The ITC encourages and supports using technology as a tool to facilitate and enhance student learning. The ITC is committed to supporting individuals in the quest for lifelong learning and enabling individuals to become leaders in the field of educational technology.

To fulfill this mission the ITC produces manuals and brochures, hosts seminars, and holds training sessions for students, faculty and staff each semester. These sessions are designed to provide hands-on experiences in the use of current technology trends in education and to promote the meaningful integration of technology into the curriculum. Student and graduate assistants are also available to help ITC patrons on an individual basis.

Our technology center is filled with the latest equipment and software for use by students, faculty and staff of the college of education. The center offers computers with internal CD burners, video editing stations, color scanners, digital still and video cameras, a color laser printer, Macintosh iBooks with firewire, and VHS conversion equipment. The ITC also has several PC laptop computers and projectors that faculty and students may check out and use for on and off-campus presentations. In addition, we offer an Assistive Technology Demonstration Lab complete with hardware and software for students with both physical and learning disabilities, as well as 300+ P-12 software titles available for preview.

In addition to our technology-related resources, the ITC also houses a textbook, video, kit and journal collection for research and lesson planning, and a letter cutter and laminator that aides in the creation of instructional materials.

50 Tools to Create a Web-Based Story: http://cogdogroo.wikispaces.com/StoryTools

Language Technology Boot Camp: http://bootcamp.pomona.edu/
APPENDIX A: NetSupport School / Tutor 8.0

→ Start button → All Programs → NetSupport School → NetSupport Tutor

1.) Scan for available clients (students’ computers)
   Groups – Only the computers in computer lab (i.e. 1-24)

2.) Lock/Unlock Students Desktops
   a) Select individual clients (use SHIFT or CTRL to select multiple clients)
   b) Menu → Client → LOCK KEYBOARD / MOUSE
      OR
      Toolbar → LOCK
      OR
      Right-Click on selected client → LOCK

3.) Blank screen when locked
   View → Current Settings → User Interface → √ Blank Screen when locking
   Mouse + Keyboard
   Blank All Screens When Locked
   School → Blank Screen

4.) VIEW Students’ Screens
   Double-Click the client’s icon
   OR
   Select (Highlight) Client’s icon → Client → View
   OR
   Right-Click the client’s icon → View

   SHARE / WATCH / CONTROL → Client → Share / Watch / Control

   To exit: Click on green arrow in lower right-hand side of screen

5.) CTRL-ALT-DELETE → Client → “Send CTRL-ALT-DELETE”

6.) View multiple clients → Window → Tile

7.) Scan through all students’ screens → Group → Scan
    OR
    Monitor Mode (See thumbnails of all screens)
    → View → Monitor → Monitor Mode Icon

8.) SHOW to students -Can show a Replay File, Videos, or Applications
    (from the Control Window menu) → Client → Show
    OR
    Right-Click on client icon, select “Show”
“Show Menu” icon → Show Dialog → Select Clients
To end, click on NetSupport button → Click “End”

9.) **Audio Support**
   a.) Make an announcement
      → Client → Announce
   b.) Audio button (Client only, Tutor only, or both)

10.) Chat with students
      → Client → Chat

11.) “Exhibit this client” – show one student’s screen to all students
     Right-click on client icon, select “Exhibit this client”

12.) Other possibilities
     Student surveys
     Test Designer (Testing Module) – separate program
     Group students together, assign one student as the Group Leader
     File transfer (cannot access the student’s Z: drive), use C:\Temp instead
APPENDIX B: AUDACITY
Use to record voice and create MP3 files

Start button ➔ All Programs ➔ Education Applications ➔ Audacity
Works like a VCR: Record, Play, Stop, etc.

If you stop recording, then begin recording again, Audacity will record the next track separately and it will overlap with the previous track both will play back at the same time), and the audio will be hard to understand. Be sure to close any track (click on the small X button on the track) that you do not want, before starting a new track.

Save files as MP3:
➢ File ➔ Export as MP3
Save files to the Z: drive or a memory stick, etc.

Then students can email their recordings to the instructor as attachments.
## United States International Keyboard Layout

**Windows XP**

**THE EASIER WAY TO TYPE FRENCH, GERMAN, & SPANISH CHARACTERS!**

<table>
<thead>
<tr>
<th>Spanish</th>
<th>Key Strokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>â</td>
<td>RIGHT ALT + a</td>
</tr>
<tr>
<td>é</td>
<td>RIGHT ALT + e</td>
</tr>
<tr>
<td>i</td>
<td>RIGHT ALT + i</td>
</tr>
<tr>
<td>ó</td>
<td>RIGHT ALT + o</td>
</tr>
<tr>
<td>ú</td>
<td>RIGHT ALT + u</td>
</tr>
<tr>
<td>ñ</td>
<td>RIGHT ALT + n</td>
</tr>
<tr>
<td>ö</td>
<td>RIGHT ALT + ?</td>
</tr>
<tr>
<td>ï</td>
<td>RIGHT ALT + !</td>
</tr>
<tr>
<td>Â</td>
<td>RIGHT Alt + A (capital A)</td>
</tr>
<tr>
<td>É</td>
<td>RIGHT Alt + E</td>
</tr>
<tr>
<td>Í</td>
<td>RIGHT Alt + I</td>
</tr>
<tr>
<td>Ó</td>
<td>RIGHT Alt + O</td>
</tr>
<tr>
<td>Ú</td>
<td>RIGHT Alt + U</td>
</tr>
<tr>
<td>Ñ</td>
<td>RIGHT Alt + N</td>
</tr>
</tbody>
</table>

**French**

<table>
<thead>
<tr>
<th>â, â, ã, ã, ã</th>
<th>Shift +6 + letter (a, e, i, o, u)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Â, ê, ê, ë, ë</td>
<td>Shift + &quot;(Quotation) + letter (a, e, i, y)</td>
</tr>
<tr>
<td>à, è, ì</td>
<td>' (Accent Grave) + letter (a, e, u)</td>
</tr>
<tr>
<td>è</td>
<td>' (apostrophe) + e</td>
</tr>
<tr>
<td>É</td>
<td>' (apostrophe) + E (capital e)</td>
</tr>
<tr>
<td>ç, C</td>
<td>' (apostrophe) + c, ' (apostrophe) + C</td>
</tr>
<tr>
<td>æ, Æ</td>
<td>RIGHT Alt + z, Right Alt + Z</td>
</tr>
<tr>
<td>Æ</td>
<td>Alt + 0156</td>
</tr>
</tbody>
</table>

**German**

<table>
<thead>
<tr>
<th>â, õ</th>
<th>&quot;(Quotation) + letter (a, o, u)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Â, Ö, Ù</td>
<td>&quot;(Quotation) + A, U, O (capital a, u, o)</td>
</tr>
<tr>
<td>ß</td>
<td>Right Alt + s</td>
</tr>
</tbody>
</table>

**Other useful characters**

| €             | Right Alt + 5                   |
|½             | Right Alt + 6                   |
|½             | Right Alt + 7                   |
| £             | Right Alt + Shift + 4           |
| «             | Right Alt + [                   |
| »             | Right Alt + ]                   |
APPENDIX D: Smart Podium Instructions

PROJECTOR INSTRUCTIONS

1. Turn the projector on by pressing the ON button located in the black panel on the surface of the Podium.

Press the ON button to turn the projector on. It will blink until the projector is fully powered. To turn the projector OFF, press and hold the off button until it turns green. The projector will then power down.

2. To choose what source the projector is displaying, press the corresponding button located beside the ON/OFF buttons on the black panel.

3. Adjust the volume by using the VOLUME knob located underneath the ON/OFF button on the black panel. Turning the knob to the right will increase the volume, while turning the knob to the left will decrease the volume.

4. When your class is over, please log off of the computer, close the drawers and doors of the podium and turn the projector off. To turn the projector off, press and hold the “OFF” button on the black panel. Once the button has turned green you may release the button. The projector will then power down.
1. To use the stylus as a mouse/pointer, remove it from the cradle and press the pointer button located at the top of the Sympodium screen.

2. To right-click using the stylus, either press the right-click button, or hold the stylus on the screen until the right-click options appear on the screen.

3. To use the stylus as a pen to write/draw on the screen press one of the pen option buttons at the top of the Sympodium screen. Select either the black, blue, red or green pen button.

4. To select an area of the screen to erase, or to erase only part of the writing on the screen, press the eraser button, then use the stylus to erase.

**TIP:**
When switching from the pen to the mouse mode, the first tap will erase the entire screen. To “undo” the erase, tap the “Click here to Restore Writing” box that appears at the bottom right hand side of the screen.
**DOCUMENT CAMERA INSTRUCTIONS**

1. Once the lights and camera are in an upright position, turn the Document Camera on by pressing the ON/OFF switch located on upper right hand corner on the surface of the Document Camera.

2. To project an image from the Doc Cam, press the “DOC CAM” button (#2) located on the black panel on the surface of the podium.

3. To capture an image with the DOC CAM, place the object on the DOC CAM base. At the lectern PC, click on “START”, then “All Programs”. Next, find the “EPSON ELPDC” program. Click to open it. Click on the “File” menu option, then choose “Capture Image”. This will capture and display the image on the lectern PC screen. To save it, click “File”, “Save As”. To view it from the projector, click the “Lectern PC” button. Use the Sympodium/Smart Board options to interact with the image.

- **CLEAR MODE**: Increases picture clarity when showing certain three dimensional objects
- **PAUSE**: “Freezes” the image of the object on the Document Camera
- **ZOOM TELE/WIDE**: Zooms in and out on an image
- **AUTO FOCUS**: Focuses the camera on the image for proper viewing
- **POSI/NEGA**: For use when showing photo negatives
- **IMAGE ROTATION**: Rotates the image 90 degrees each time pressed
- **LAMP UPPER/BASE/OFF**: Toggles to turn the upper lamps on, base lamps on, and turns the lamps off

**PLEASE REMEMBER TO TURN THE DOCUMENT CAMERA OFF WHEN NOT IN USE**
APPENDIX E: Instructions for Foreign Language Placement Exam (FLPE)

Foreign Language Placement Exam  
Department of Modern Languages – Winthrop University

Follow these instructions **STEP BY STEP.**

1.) Log on to the computer.  
   - use the username **visitor**  
   - use the password **winthrop**

2.) Open a web browser, either Internet Explorer or Firefox. **OR** Click on the icon that says “Modern Languages Placement Exam,” and skip to Step 5.

3.) Go to the website [http://webcape.byuhtrsc.org/](http://webcape.byuhtrsc.org/)

4.) Select “Winthrop University” from the pull-down list.

5.) Enter the password for the exam.  
   The password is **XXXX** [This password will change periodically. See the lab director or Department chair for the current password]

6.) Choose the language of the test: Spanish, French or German.

7.) Fill out the form with your first name, last name,  
   ID number (your student ID number issued by Winthrop),  
   and your email address (whatever account you actually check)

8.) The test will be multiple choice, and should take 20-30 minutes to complete.

**DO NOT USE THE FORWARD OR BACK ARROWS TO NAVIGATE THROUGH THE TEST.** If you do, the test will give an error message and you will have to start over from the beginning.  
**IF AN ERROR OCCURS** and you have to start over, please let one of the test administrators know.

You will be given a score and course placement at the end of this test.  
**WRITE DOWN THIS SCORE AND YOUR PLACEMENT LEVEL.** This score will also be given to your academic advisor before you schedule your classes.